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Introduction to Bluebeam Revu  
This is a guide for how to use Bluebeam Revu for your PDF markup and collaboration needs. 

  

Bluebeam Revu provides powerful and easy to use features for marking up Architecture,  

Engineering, and Construction (AEC) plan PDF documents.  The Studio Session feature allows  

users from any location to participate in a collaborative review.  Bluebeam makes use of Amazon  

Web Services (AWS), commonly referred to as the Amazon Cloud. This service will host the  

documents for the Studio Session. 

    

There are two roles within a Bluebeam Studio Session.  That of an initiator, and that of a  

participant.  If you are going to initiate a Studio Session you need to have any tier of Bluebeam  

Revu installed on your pc.  However, to be a participant all that is required is Bluebeam Vu (a  

free PDF reader), though Bluebeam Revu can be used as well.  

 Initiator Install Bluebeam Revu 

Participant  Install free Bluebeam Vu 
download (unless the partici-
pant already has Bluebeam 
Revu)  

How to Use This Guide  
 

Each section of this reference guide  will begin with a description of the topic that will be  

covered, followed by step-by-step instructions on how to accomplish it.   
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Default PDF Associations  

In a mixed environment (using both Adobe Acrobat & Bluebeam Revu), a choice has to be made 
as to which PDF reader is set as the default PDF reader. In most cases this is generally just a user 
preference, but in a mixed environment leaving Adobe Acrobat as the default PDF reader is 
recommended. This is recommended because Acrobat Shared Review invitations use the default 
PDF reader to open links to the Shared Review, while Bluebeam Studio Session invitations know 
to use Bluebeam Revu regardless of whether or not it is the default PDF reader. In this scenario a 
user could navigate both invitations without running into any problems.  

In the case that you are NOT in a mixed environment, shown below are instructions for setting 
Bluebeam Revu as your default PDF reader in Windows. 

 Setting the default PDF reader in Windows  

From within Bluebeam Revu, click the drop-down menu next to 
the Bluebeam Revu symbol in the upper right corner of the 
screen, then click on Administrator.  

 

 

 

 

 

 

 

 

On the Bluebeam Administrator 
dialog, select the Revu tab. In the 
Bluebeam Revu section check the 
Use as Default PDF Viewer 
checkbox, then click OK.  
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Joining a Review Session 

To join a review session, click on the link 
provided in the Session invite. 

When the Internet Explorer window 
appears. Check “Do not show me the 
warning for this program again” and on 
the next screen uncheck “Always ask 
before opening this type of address” and 
click on Allow.  These windows should 
not appear again. 

 

 

 

 

 

Bluebeam will launch.  If this is your first time 
into a review session, create a Studio 
account.  

DOT Staff: 

Enter your State email address and a 
password. Enter your name as you want it to 
show up in the review comments (Do not leave your 
computer number).  Select “Remember password” and 
select “Allow other users to see my e-mail”.  Click OK 
 

Other Reviewers: 

Enter your email address and a password.  Enter your 
name as you want it to show up in the review comments.  
Select “Remember password” and select “Allow other 
users to see my e-mail”.  Click OK 

If this is not your first time in a review session, you may 
have to enter your studio log in information if you forgot 
to check “Remember Password” 
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Review Session Layout 

When you enter a Bluebeam review session you will see the Studio Session Tab located on the 
right hand side of the screen.  This tab displays the attendees of the session, a list of the documents 
in the session, and a record of all actions that take place on a review document.  On the bottom of 
the screen you will see the list of all comments placed on a document.  If this bottom tab is not 
open, click on the blue half circle with the white dot in the middle.  On the left of the screen you can 
have the the Tool Chest open with your own comment tools or other options. 

All comments that are made get saved instantly to the Bluebeam review session; you do not need to 
manually save any comments.  You can only delete comments you have made.  If someone else 
has made a comment that you would like respond to just right click on their comment on the plans 
or in the Markup List and select reply. 

You can leave and rejoin sessions as many times as you want as long as the review session has 
not been closed.  The review session will be closed by the Project Manager (Host) in accordance 
with the procedures shown in this manual. 

 

 Tool Chest  -  Save your 
own comment tools that 
you use in reviews 

 Review Session Tab 

 Status in the Review 
Session 

 Attendees 

 Documents in the 
Review Session 

 Click here to open and 
close Comment List 

 List of Comments/
Markups 

 Split Screen Buttons 
Allowing Viewing of 
Multiple Pages at the 
Same Time. 

 Record, Notification 
and Message Center 

 Markups List Button Bar 
to Filter, Set Status and 
Reply to comments 
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Reviewing Plans 

Reviewers may print digital review documents to 
paper and mark them up; however, they must 
transfer these comments onto the digital review 
documents.  Any written comments that are 
received can be scanned to a PDF and attached 
to the session documents using the attach file 
command.  Please be careful when you place a 
comment or markup so that you do not cover up areas of notes or details that may need to be 
review by other individuals. 

1. All reviewers must set your review status to “Reviewing” by clicking on the drop down arrow 
shown to the right.  Note:  If you leave the session and return your status will stay as Reviewing. 

2. Next select a document to review from the studio session tab.  Note:  There may be more than 
one document is a session review.  Example: DOT Plans and Utility Plans. 

3. Proceed to make comments using the various markup tools.  Make comments on other reviewer 
comments by right clicking on the comment and selecting reply. 

4. After your review of the documents is completed set your status to “Finished”.  This status lets 
the Project Manager (Host) know which Reviewers have completed their reviews.  Note: You 
can still enter the session if your status is set to Finished. 

5. If a review comment is rejected, the reviewer will receive an Alert email from the Consultant/ 

      Designer that rejected your comment. See pages 83-84 of this manual. 

Commenting Best Practices 

A text note can be added to any of the other comment tools by double clicking on the markup after 
you place it.  The text note box must be closed after the comment is made by clicking on the X in 
the top right corner of the note.  The example below shows a note being attached to the rectangle 
tool. 

 1. Place Rectangle  2. Double Click on the rec-
tangle to place note. 

 3. Close the text 
box by clicking on 
the X. 
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Chapter 1: Interface  
 

Interface Overview  

At the top of the Revu window you will see the Command Bar. The Command Bar provides access 
to tools and commands organized by group. Below the Command Bar and to the right edge are op-
tional Toolbars. These toolbars provide customizable, one-click access to the tools you need most. 

There are three Panels around the Main Workspace which contain a number of tabs. These tabs 
provide quick access to tools for viewing, navigating, annotating and gathering information from a 
PDF. Revu provides Left, Right, and Bottom Panels and places commonly used tabs in them by 
default, but you can freely move any tab to any panel, and it is even possible to detach a tab into a 
floating panel for more flexibility. To detach a tab, click and drag it off the panel area. Once you 
create a floating panel, any number of tabs may be added to the panel.  

Bottom  

Left Side  
Right Side  
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Below the Main Workspace but above the bottom panel, notice the Navigation Bar, which contains 
tools to help navigate documents. This bar is customizable like a Toolbar. At the very bottom of the 
application window, below the bottom panel, sits the Status Bar, which contains additional infor-
mation and tools to help you interact with PDFs smoothly. 

 

Navigation  

The Navigation Bar is located between Revu's Main Workspace and the Bottom Panel. The Naviga-
tion Bar enables efficient movement between pages and views in the Main Workspace. 

  

1.   Unsplit: Eliminates the current split. 

2.   Split Vertical: Engages MultiView™ and divides the workspace into two verticallyoriented splits. 

3.   Split Horizontal: Engages MultiView™ and divides the workspace into two horizontallyoriented 
splits. 

4.   One Full Page: A single page of the PDF displays. The mouse wheel will zoom in andout of the 
page. 

5.   Scrolling Pages: Pages of the PDF files display in a column. The mouse wheel will scrollup 
and down the pages. 

6.   Pan (Esc or Shift+V): Click and drag to pan the image. 

7.   Zoom (Z): Click to zoom in; hold Ctrl and click to zoom out. 

8.   First Page (Home): Jump to the first page of the PDF. 

9.   Previous Page (Ctrl+Left): Go to the prior page of the document. 

10.  Next Page (Ctrl+Right): Go to the next page of the current document. 

11.  Last Page (End): Jump to the last page of the document. 

12.  Previous View (Alt+Left): Go back to the previous view in the main workspace. 

13.  Next View (Alt+Right): Go to the next view in the main workspace.  
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Status Bar  

 

The status bar is located at the bottom of the Revu desktop. The left side includes prompts to help 
you use the current command or tool. The right side includes the size of the current PDF page and 
the current cursor position.  

To display the Status Bar:  

 

 • Press F8 

  -or- 

 • On the Command bar, click View> Interface > Status Bar. 

 

There are six toggle buttons in the middle that switch features on and off:  

Grid (Shift+G): Displays the visible grid to aid in placement of markups. The grid spacing is config-
ured through the Preferences. Click Settings/Preferences/Grid & Snap.  

Snap (Ctrl+Shift+F9): Forces the cursor to move along the defined document grid. The grid spac-
ing is configured through the Preferences. Click Settings/Preferences/Grid & Snap. The grid can 
be made visible by toggling on the Grid button on the Status Bar or in Settings.  

Content: Toggles whether or not elements of markups will snap to underlying content. The snap 
will connect to the endpoints or the midpoints of the elements. Change the settings for this option in 
Preferences. Click Settings/Preferences/Grid & Snap.  

Markup: Toggles whether markups will snap to other markups when they are created.  

Reuse: Enables the same markup to be added to the PDF without having to reselect the button on 
the toolbar. This mode is helpful when adding the same markup onto the PDF sequentially.  

Sync: Synchronizes the two viewing windows when displaying the PDF in side-by-side Split View 
mode or in a detached window. This is useful when you need to compare two different versions of 
the same document. Moving the document in one window will automatically adjust the view in the 
second window  
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Command Bar Groups  

As mentioned earlier, groups of menu buttons display in the center or the Command Bar and are 
interchangeable depending on the Menu you have selected. There are nine menu groups:  

File  

The File group contains menus buttons associated with creating, combining, importing and export-
ing, and batch processing documents.  

Edit  

The Edit group provides menu buttons pertaining to object and text manipulation.  

View  

The View group contains menu buttons to change the look of the workspace and open documents.  

Document  

The Document group provides menu buttons for working with PDFs.  

 15 



Markup  

The Markup group contains menu buttons for adding markups to a PDF.  

Measure  

The Measure group contains the Measurement and Calibration tools plus quick access to the 
various measurement modes.  

Window  

The Window group includes menu buttons for controlling the main workspace window.  

Help  

The Help group contains menu buttons that link to help and other resources.  
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Tabs  

The three attached panels and any floating panels you have 
created can hold a number of powerful, specialized tabs, which 
provide efficient access to a variety of Revu features. This 
section covers the most used tabs and the functionality each 
enables.  

Properties Tab  

The Properties tab displays any attached files and metadata 
about the currently active PDF. If a markup or group is 
selected, the Properties tab will display the specific appearance 
of the selected markup or group. By default, the Properties tab 
appears in the right panel.  

To display the Properties tab, click                   properties or 
press Alt+P.  
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File Properties Sections  

If no markup is selected, the currently active file's properties are displayed in the Properties tab.  

File Attachments Section  

The File Attachments section lists any attachments saved in the current document. Click a file to 
select it, then use the tools in the File Attachments button bar to open, save, or delete it. Double-
click a file name to open it.  

File Attachments Button Bar  

 

 

 1.  Open: Opens the selected file. 

 2.  Save: Saves a copy of the selected file locally, outside of the document it's attached to. 

 3.  Add New: Uses an Open dialog to select a file from your computer to attach to the  

                current document. 

 4.  Delete: Removes the selected attached file from the document.  
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File Properties Section  

The File Properties section displays, and allows editing of, the following metadata fields: Title, Au-
thor, Subject, Project, Revisor and Client.  

File Custom Properties Section  

The Custom Properties section displays, and allows editing of, additional custom metadata.  

To add a new field, click an empty cell in the Name column, type a name for the property, then click 
in the corresponding Value column cell and add the value. To delete a custom row, click in either 
cell and click Delete.  

Markup Properties Sections  

When a markup is selected, the tab displays all of the parameters that are configurable for that par-
ticular markup.  
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General Section  

The General section is different for different 
markups, but will often contain a comment 
preview window, Author and Subject fields, 
and a Lock checkbox to avoid accidentally 
moving or changing the markup.  

 

 

 

 

 

 

 

 

Appearance Section  

This section contains settings pertaining to the 
display style of the markup. See the sections 
on individual markup tools for what specific 
appearance settings are available for that tool.  
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Layout Section  

This section reports where the markup exists on the document page. Enter values to place 
markups precisely. If you move a markup by clicking and dragging, the change is reflected here.  

Options Section  

This section will also vary from markup to markup, but generally holds a quick menu to allow adding 
the current tool to My Tools or any tool set in your tool chest and a button to make the current set-
tings the default for that tool.  

Thumbnails Tab  

The Thumbnails tab displays small previews of PDF pages for quick navigation within a multi-page 
document. By default, it appears in the left panel.  

To display the Thumbnails tab, click                Thumbnails or press Alt+T.  
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Thumbnails Button Bar  

 

 1.  Reduce Thumbnail Size: Reduces the size of the thumbnail images. 

 2.  Increase Thumbnail Size: Enlarges the thumbnail images. 

 3.  Show/Hide Page Label: Toggles page labels on or off underneath the individual 

                thumbnails. 

 4.  Create Page Label: The AutoMarkTM technology allows automatic Page Label  

                modification based on Bookmarks or a specified Page Region on the PDF that is  

                consistent on each page. 

Bookmarks Tab  

Revu recognizes existing bookmarks in PDFs and enables users to create and edit bookmarks as 
well. Bookmarks contained in a PDF are displayed in the Bookmarks tab. For more information, see 
the section on Working with Bookmarks.  

When generating PDFs from other file types using the Bluebeam PDF creation tools, certain con-
tent will be automatically transformed into bookmarks – for example, a Microsoft® Word table of 
contents, worksheet labels from Excel® and slide headers in PowerPoint®. When using Auto-
CAD®, Revit® or SolidWorks®, bookmarks can be created from layout sheets as well.  

To display the Bookmarks tab, click                  Bookmarks 
or press Alt+B.  

Left-pointing triangle icons along the right side of the book-
mark list indicate bookmarks associated with the current 
page. A bookmark will not have this symbol if it links to an 
element on a different page.  
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Bookmarks Button Bar  

The Bookmarks button bar contains tools to organize and navigate bookmarks.  

  

 1.  Expand All: Expands the entire bookmarks list. 

 2.  Collapse All: Collapses the entire Bookmarks list. 

 3.  Save Collapse State: Saves the current Collapse/Expand state as the default (requires 

                that the file be saved as well to retain this default across sessions). 

 4.  Create Bookmarks: Makes a new bookmark and allows you to specify the name,  

                viewing scale and page range. With AutoMarkTM, bookmarks can automatically be  

                created from existing page labels or text found in a specific region on each page of the 

                document. 

 5.  Add: Adds a bookmark to the current page, visible below the currently selected  

                bookmark in the bookmarks list. 

 6.  Delete: Deletes the selected bookmark(s). 

 7.  Action: Opens the Action dialog, which allows the user to insert a hyperlink into a  

                bookmark. 

 8.  Properties: Opens the Bookmark Properties dialog. 

 9.  Audit Bookmarks: Analyzes the bookmarks list to ensure the links still work. 
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Search Tab  

The Search tab allows you to search for text in the current PDF, all open PDFs, PDFs in a folder, or 

in the files in the Recents list. You can perform a Text search or a Visual search. You can also 
Search and Replace.  

 

 • To display the Search tab, click                        Search or press Alt+1 or Ctrl+F.  

 

Text Search  

Text must be present in the PDF file for text search to find it. Scanned PDF files are images and do 

not contain any text, so they are not searchable. See Optical Character Recognition (OCR) for de-
tails on how to make scanned documents searchable.  

VisualSearch  

VisualSearch allows for the searching of graphical symbols in PDFs. To set the search criteria, de-
fine a rectangle around the symbol or graphic that you want to search for in the document.  
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Working with Profiles  

Profiles provide an easy way to store the toolbar, menus, and other display settings within Revu. 
Profiles can also be used to shape the User Interface of Revu for particular job functions within your 
organization. For example, you may create a simplified interface, turning off most of the toolbars 
within Revu, for those users within your organization who would only be viewing PDFs and not have 
need to edit PDFs. Additionally, you could turn on only the most basic markup functions without any 
of the advanced editing functions and save a profile for basic markup users.  

 

 

The toolbar settings are available from the Profile                        button menu. The check next to the 
profile name indicates the currently active profile setting. To switch to a different profile, select 
another profile from the menu. Once selected, the Revu interface will update based on the settings 
defined in the new profile.  

 

Preferences  

The Preferences dialog enables customization of Bluebeam Revu settings. This section briefly 
describes some commonly used settings, organized by the section of the preferences dialog that 
contains it.  

To invoke the Preferences dialog:  

  

 • On the Command Bar, click Settings, then click Preferences. 

  -or- 

 • Press Ctrl+K. 

 

Some commonly changed preferences will be discussed in this section.  
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General  

User: Each time a markup is 
made, Revu records who 
made it. This field defines 
the name to use.  

Enable Document 
Recovery: If Revu quits 
unexpectedly with this option 
set, the next time Revu is 
started, it will attempt to 
recover unsaved changes to 
the document(s) open in the 
previous session.  

Allow Multiple Instances: 
This enables or disables the 
Multi-Revu feature.  

Enable Auto-Complete: Remembers previously entered text. Click the Manage button to edit the 
auto-complete history.  
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Show Splash Screen: Enables or disables the Revu splash screen when Revu is first launched.  

Use Large Icons: The User Interface Icons will be displayed larger and support High Resolution 
Displays.  

Reset Hidden Messages: Resets the display of the dialog boxes where "Don't Show Again" was 
selected.  

Tab Truncation: Determines if the file name in the opened tab, truncates the beginning or end of 
the name.  

Brightness: Sets the overall brightness of the Revu interface.  

Classic Mode: Switches to an emulation of the appearance of the default interface for Revu prior 
to version 6.  

Classic Menu: Switches the menus to classic menus.  

Grid & Snap 

  

Units Section  

Application Units: Defines 
the system of measurement 
to use for rulers and 
measurement dimensions.  

Grid Section  

Show Grid: Provides control 
over displaying the grid. Also 

Snap to Grid: Makes any points used to define a markup line up with the defined grid. Also 
controlled by the Snap button on the Status Bar.  

Grid Spacing: Controls increments between grid units, which affects the snap-to resolution as 
well as the spacing of the grid markers that are displayed on the PDF. A smaller increment makes 
a smaller grid, a larger increment makes a larger grid.  
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Snap  

Snap to Content: Snaps markups to the underlying PDF vector content. A small 
box appears over the underlying PDF content when markups are being made. The 
following image demonstrates the behavior as a line markup is being drawn. Snap 
to Content does not snap to text or images in the PDF, only vector images such as 
lines and shapes. It is also controlled by the Content button on the Status Bar.  

 

Snap to Markup: Snaps the cursor to other markups in the PDF. This can also be controlled by the 
Markup button on the Status Bar.  

With Snap to Markup enabled, two related behaviors will occur. The cursor will snap to points on 
other markups, like Snap to Content snaps to points in the PDF content. Revu will also display – 
and the cursor will snap to – guidelines that are based on lines in nearby markups.  

 

Snap to a point          Guidelines creating a Polygon             Guideline creating aligned Rectangles  

Snap Color: Determines the color of the indicator box.  

Sensitivity: Move the slider to High to make the snap area smaller. Move the slider to Low to 
make the snap area larger.  
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Markup  

Reuse Markup Tools: If checked, the last markups used will remain selected so it can be used 
over and over again. If unchecked, after a markup is placed Revu will switch back to pan mode.  

Dynamically Set as Default properties: Remembers the last property settings for a markup. For 
example, if the appearance properties for a rectangle markup were set to a Green color, 2 point 
wide line, the next time that the rectangle markup is selected, these properties will be used.  

Autosize Text Box and 
Callout Markups: Fits the 
surrounding text box to the 
entered text for a callouts 
and text markups. After 
editing the text in a Free 
Text or Callout markup, the 
text box will resize 
automatically to fit the text.  

Embed Fonts: Includes 
fonts used for markups in 
the PDF.  

Show Author and Date in 
Pop-Ups: Displays Author 
and Date in popup notes 
when an markup is double-
clicked. The title and author 
will also appear when a note 
markup is added to a PDF.  

Print Pop-Ups: Check to print Notes and Comments popup boxes.  

Opacity: Opacity level that Notes and Comments popup boxes will be printed if Print Pop-Ups is 
checked.  

Copy Selected Text into Text Markups: Any time a text markup is used, the annotated text will 
be copied to the copy buffer so that it can be pasted into other applications. Text markups are 
Highlight, Underline, Squiggly line, and Strikethrough.  

Retain Layer Info when copying Markup: Layer information will be copied when you copy a 
markup. If you copy a markup to another PDF, its layer will be created in the new PDF.  
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Use Relative Paths for Hyperlinks and Actions: Set the default status for paths to be "relative" 
when Hyperlinks and Actions are created.  

Set 'Open in New Window' option for Hyperlinks and Actions: Set the option to open a 
Hyperlink or Action in a new window when the Hyperlink or Action is created. This option only 
applies when viewing PDFs in Acrobat or Reader. Revu already opens the links in a new tab.  

Default Image Encoding: Chooses the format in which embedded images and inserted image 
markups are stored in the PDF.  

Drag Behavior for Shapes: Determines whether, when drawing certain shapes (polygons, area 
measurement), a rectangle is used or whether the drag behavior sets control points for the Bézier 
curves used to define the shape. The effect will be either a rectangle is dragged, or a curve shape 
will be drawn.  

 

Navigation 

  

Mouse Wheel Section  

Set how the mouse wheel 
behaves in this section.  

Single Page Mode: Sets the 
mouse wheel behavior in single 
page mode. Choose either 
Zoom or Scroll.  

Continuous Mode: Sets the 
mouse wheel behavior in 
continuous mode. Choose 
Zoom or Scroll. This behavior is 
independent of the Single Mode 
setting.  

Reverse Mouse Wheel when 
Zooming: Changes the 
direction for when the mouse 
wheel will zoom in versus zoom out.  

Sensitivity: Controls how much the zoom level changes per mouse wheel click.  

Enable Horizontal Mouse Wheel: Enables panning for mice that have tilt-able scroll wheels.  
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Options Section  

Synchronize Views: Synchronizes the viewing windows when displaying the PDF in side-by-side 
Split View mode. The Mode can be changed to sync by Document or by Page. For example, this 
is useful when you need to compare two different versions of the same document. Moving the 
document in one window will automatically adjust the view in the other window(s). This can be 
quickly toggled on and off with the Sync button in the Navigation bar.  

Enable Horizontal Scrollbar: Toggles on and off the horizontal scroll bar at the bottom of the 
document tab.  

Show Vertical Scrollbar on Left: Displays the vertical scrollbar on the left side of the PDF page 
instead of the right.  

Lock Panning in Fit Width: Constrains panning to vertical movement when in Fit Width mode. 
This prevents the page from sliding sideways if the mouse is moved slightly horizontally.  

Maximum Zoom: Sets the maximum percentage the workspace will allow zooming of PDFs.  

Enable 3D Mouse: Enable 3D navigation with a 3D mouse.  

 

Studio 

  

Account  

Change your account settings, 
create an account or login to 
Studio.  

Checkout on Open: If this 
option is selected, when a 
Studio Project file is opened, it 
is automatically checked out.  

General  

Enable Sounds: Play sounds 
with studio events.  

Enable Flashing Alerts: Turn 
off visible flashes with studio 
events.  
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Chapter 2: Commenting & Markups  
 

Compatibility  

Comments made in either Acrobat or Revu can be seen in both without any issue. If you add 
comments to a PDF from within Adobe, you can open the PDF and see those comments even in 
Revu.  

Markup Overview  

The tools to create and edit markups can be found in the Markup and Measure groups of the 
Command Bar, in the Text and Shapes toolbars, and in the Tool Chest tab. In addition, most 
markup tools have convenient keyboard shortcuts. Each time a markup tool is selected and used, 
the markup is stored in the Recent Tools section of the Tool Chest tab.  

Markup Tools  

The Markup group contains menus and commands to allow the markup of PDFs.  

 32 



Text Menu  

The Text menu contains tools to create text-bearing markups.  

 

Text Box (T): Adds a text markup. 

  

Callout (Q): Adds a text callout. 

  

Typewriter (W): Enables freely typing text on a PDF. 

  

Note (N): Adds a sticky note. Caution: If any popup text windows are closed, the popup text of 
those markups will not show up when printing.  

 

Flag (F): Adds a linked flag on the currently active page. 

  

Pen Menu  

The Pen menu contains markup tools that behave in a similar manner to a real-world pen. 

 

 

 

 

 

Pen (P): Adds a free-drawn markup. 

  

Highlight (H): Adds a semi-transparent line simulating a highlighter. 

  

Eraser (Shift+E): Removes pen and highlighter markups.  
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Lines Menu  

The Lines menu contains tools to create linear markups.  

 

Line (L): Adds a line. Hold Shift to snap line in 45° increments.  

 

Arrow (A): Adds an arrow markup. 

  

Arc (Shift+C): Adds an arc markup. 

  

Polyline (Shift+N): Adds a segmented line. 

  

Dimension (Shift+L): Adds a dimension or leader line markup on the PDF.  

 

Shapes Menu  

The Shapes menu contains tools to create outlined shape markups. 

  

Rectangle (R): Adds a rectangular markup. 

  

Ellipse (E): Adds an elliptical markup. Hold Shift to make a circle.  

 

Polygon (Shift+P): Adds a polygon markup with no defined angle. Click to set each point, then 
press Enter or double-click to finish. 

  

Cloud (C): Adds a polygon with a cloud-like appearance preset.  

 

 Cloud +(K): Adds a polygon with a cloud-like appearance preset and a text box. 
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Sketch Menu 

 

 

 

 

 

 

 

Polygon Sketch to Scale: Adds a polygon markup to an exact scale. 
 

Rectangle Sketch to Scale: Adds a rectangle markup to an exact scale. 
 

Ellipse Sketch to Scale: Adds an ellipse markup to an exact scale. 
 

Polyline Sketch to Scale: Adds a polyline markup to an exact scale. 

 

 

Image and Image Menu  

 

Image (I): Inserts an image from a graphic file accessible on your workstation. Click to the right to 
access the Image Menu. 

 

 

 

 

 

Image from Scanner (Shift+I): Displays the Scanner dialog to acquire images from a 
scanner or camera. Images captured result in new image markups.  

 

Crop Image: Crops an image markup. Click and drag to define a rectangle. Areas of the 
image markup outside the rectangle will be eliminated.  
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Hyperlink and Hyperlink Menu  

 

Hyperlink: Allows the creation of hyperlinks in a PDF. Click to the right to access the Hyperlink 
Menu.  

 

 

 

 

 

   Create Hyperlinks from URLs: Creates hyperlinks from URLs that exist in the PDF content.  

 

Attachment  

Attachment: Opens the Add Attachment dialog to allow embedding a file in the PDF.  

 

 

 

Stamp Menu  

The Stamp Menu can be used to add "rubber stamp" 
comments on the drawing.  

This tool is what you will use to work with the out-of-the-box 
stamps or any stamps that you create yourself. Any 
standardized stamps will be accessed via your section 
specific stamp Tool Sets. For more information see the 
Working with Stamps section.  
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Measurement Setup  

The Measurements tab provides access to the measurement modes, allows setting the document 
scale, setting up Viewports for multiple scales in the same document, and other measurement 
options.  

To display the Measurements tab, click           >           Measurements or press Alt+U.  

Calibrating a PDF  

The Calibrate button brings up the Calibrate dialog to allow accurate measurements to be taken 
from a PDF. First, locate a labeled, known length somewhere on the PDF.  

 

 •  On the Command Bar, click Measure, then click               Calibrate.  

 -or-  

 •  On the Measure toolbar, click               Calibrate.  

 -or-  

 •  In the Scale section of the Measurements tab, click             Calibrate.  

 •  Click OK. 

 •  Click the first point of the known length, then click a second point to finish the line. You 

               can hold down the Shift key to snap the two points horizontally. 

 •  Enter the distance that these two points represent on the drawing and click OK. 

 

NOTE: If you are working with a vector-based drawing (as opposed to a scanned PDF), you 
can enable Snap to Content which makes the cursor snap to the underlying lines and 
drawing elements, making it much easier to accurately select the two points.  
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Alternatively, if you already know the scale, enter the values 
in the Scale section of the Measurements tab. It is 
recommended to always use Calibrate if possible, as 
sometimes scaling occurs during the PDF creation process.  

The unit drop down list determines the units in which the 
measurements will be reported. In the preceding example, 
the result will be displayed in “feet-inches”.  

Precision determines the decimal or fractional precision of 
the measure value displayed.  

 

Working with Viewports  

Different scale zones can be defined within a drawing or 

document by clicking the Add button in the Viewports 
section of the Measure tab. To define the region on the page, 
click and drag a rectangle around the area the scale should 
apply to, and then type the viewport Name. Once the area is 
defined on the PDF, click the Calibrate button and select two 
points within the viewport to define the scale.  

When the viewport name is selected in the list, the viewport 
area, name and scale will display in the drawing.  

Note: When a measurement is placed on a PDF with 
Viewports defined, the Viewports are highlighted with their 
associated scales displayed. If you notice a viewport that is 
untitled, this could be affecting the accuracy of your 
measurements in that area. In this case, the untitled 
viewport should be deleted.  
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Measurement Tools  

The Measure group contains the Measure and Calibrate tools plus quick access to the various 
measurement modes.  

 

Measure Tool  
 

Measure (M): Creates a temporary measurement or markup in any of eight measurement modes.  

Calibrate  

Calibrate: Calibrates the scale to allow accurate measurements to be taken.  

Linear Menu  

The Linear menu contains linear measurement modes.  

 

Length: Calculates a linear measurement.  

 

Perimeter: Calculates the length of all the sides of a given shape or multi-segment line.  

Area  

Area: Calculates the area of a simple rectangle or of an irregular, polygonal shape.  

Volume  

Volume: Calculates the volume of an area with a defined depth.  

Cutout  

Cutout: Allows you to cut out or subtract an area from an existing Area or Volume measurement.  

Count  

Count: Places a markup for each mouse click, associating a running total of counts with each 
markup as it is placed.  

Geometric Menu  

The geometric menu contains measurement modes that calculate angles and circular features.  
 

Diameter: Calculates the diameter of a circular shape. 
  

Angle: Measures a given angle as defined by three points.  
 

Radius: Measures the radius of an incomplete circle defined 
by three points along the arc.  
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The Tool Chest  

The Tool Chest is a powerful feature that makes the marking up of documents much more efficient. 
Once a markup is created, it can be easily recalled using the Tool Chest. The Tool Chest will store 
your most used markups in a central, easily accessible location.  

 

By default the Tool Chest is in the left panel. To access the Tool Chest, click           >          Tool 
Chest or by press Alt+X.  

Using Tool Sets  

Click any tool in the Tool Chest to select it, then click on the document to place the markup.  

To copy a tool from one tool set to another tool set:  

 •  Click and drag the icon to the desired tool set. 
 

To reorder the tools within a set:  

 •  Click and drag the icon to the desired location.  

To delete a saved tool:  

 •  Click a tool to select it, then click the               Delete Icon on the Tool Chest button bar.  

 -or-  

 •  Click a tool icon to select it, then press the Delete key. 

 -or-  

 •  Right-click a tool icon, then click Delete. 
 

To duplicate a tool:  

 •  Right-click a tool icon, then click Duplicate. 
 

To change the colors of a tool:  

•Right-click a tool icon, then click Change Colors. 

 

Reusing Recent Tools  

The Recent Tools section records every markup as it is added 
to the PDF.  

To reuse a tool, simply click the icon and then click on the PDF 
to place the markup.  

The Recent Tools history is temporary; it only lasts until Bluebeam Revu is closed.  
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Permanently Saving a Tool to be Reused  

To save a recently used tool so it will remain after the program has been closed, click and drag the 
tool's icon from Recent Tools into My Tools or another tool set, or right-click the icon and then click 
Add Item to My Tools.  

To save a markup on the document as a reusable tool, right-click the markup, hover over Add to 
Tool Chest, then click the tool set to save it to (For example, My Tools).  

Managing Recent Tools  

If too many tools have been used recently to view them all in the Recent Tools section, an arrow 
appears to the right of the row. Click the arrow to access all recent tools.  

 

 

 

 

 

 

To set how many recent tools to retain: 
  

 •  Click the             gear at the top right of the section, then hover over Maximum Recents. 

 •  In the Maximum Recents submenu, click a value to set the number of recents. 

 

Clearing Recents and Hiding the Recent Tools Section  

To clear all recent tools without closing Revu:  

 •  Click the           gear at the top right of the section. 
 

 •  Click          Clear Recents.  

 

To Hide the Recent Tools Section:  

 •  Click the           gear at the top right of the section, then click Hide. 

 

Click the           Manage Tool Sets menu in the Tool Chest button bar, then click Recent Tools, to 
show it again.  
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Properties Mode vs. Drawing Mode  

Items in My Tools, Recent Tools and custom tool sets can function in two different modes. The 
tool icon changes to show which mode is currently being used.  

 

                                         

Drawing Mode                                                                   Properties Mode        

 

Properties mode adds a new markup with the same display properties of the saved markup. In 
this mode the Properties (as displayed in the Properties tab) are retained but the exact 
dimensions, text, and so on are not. In the preceding example, using the tool in Properties mode 
would create a new yellow text box with black border and text color, but no text would be inside 
the box yet, nor would the box have a fixed size.  

Drawing mode adds a new markup that is an exact duplicate of the saved markup, as if you'd 
copied and pasted the original markup rather than made a new one of a similar type.  

To change the mode, double-click on the icon. All information of the original markup is always 
retained when switching modes. Only the icon and the way that the markup is added to the file 
changes when the mode is switched. By default, most tools are saved in Properties mode. There 
are some markups that always remain in Drawing mode. A Stamp and a Grouped markup are two 
examples.  

To set all markups to default to Drawing mode: 
  

 •  Click the            gear at the top right of the section, then uncheck Properties Mode. 

 

Sequences & Actions  

A Sequence allows a text based markup to increment in value each time that a markup is added 
to the PDF. The updating sequence value can be a number or text. An Action allows you to add 
hyperlinks to tools in the Tool Chest.  

Pinning a Tool Set  

 •  For quick and easy access, a Tool Set can be pinned to any Toolbar. 
 

 •  Click the small          gear to the right of the Tool Set name. 
 

 •  Click          Pin to Toolbar, then select the specific Toolbar.  

 

 

                                       

← Double-click →  
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Working with Stamps in the Tool Chest 

Standardized stamps can be delivered via section specific Tool Sets in the Tool Chest. Here are 
some examples:  

 

 

 

 

 

 

 

 

 

 

Placing Stamps from the Tool Chest 

To place a stamp:  

 •  Click the thumbnail of the stamp you would like to place from the desired Tool Set. 

 •  Click the PDF in the location you would like the stamp to appear. 
 

Unlike placing a stamp off of the Stamp Menu, placing a stamp from a Tool Set produces a 
dynamic preview of the stamp on your cursor. This feature results in much easier stamp placement.  
 

Applying a Stamp from the Tool Chest to 
Multiple Pages  

There are a few options for applying a stamp to 

multiple pages, the Apply to … Pages context 
menu options, and the Apply Stamp tool.  

Apply a Stamp from the Tool Chest to All 
Pages  

This will copy and paste in place any markup on all 
the pages of a PDF.  

 •  Right-click a markup, then click Apply to 

              All Pages. 
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Apply a Stamp from the Tool Chest to Selected Pages  

Apply to Selected Pages works like Apply to All Pages, but instead applies the markup to the 
pages that are currently selected in the Thumbnails tab. 
  

 •  In the                Thumbnails tab, hold Ctrl and click to select pages while leaving the  

              markup selected. 

 •  Right-click the selected pages and then click Apply Stamp the Apply Stamp dialog box  

              appears then select the Stamp and click OK. 
 

Apply Stamp Tool  

The Apply Stamp tool can be found in the Document group of the Command Bar under the 
Pages pull-down menu.  

 The Apply Stamp dialog gives you more control on how you would like to apply a stamp. This 
dialog includes all the general stamp placement options as well as the ability to apply a stamp to 
page ranges in multiple files, or even specify an anchor point option that could prove useful on 
PDF’s of differing page sizes.  

To Import Stamps into the Stamp Tool 
  

 1.  Go to Markup >                   Stamp > Import Stamp 

 2.  Select the PDF file that you want to import into the Stamps folder and click Open 

The location for the SDDOT “Not For Construction” and Preliminary Stamps is as follows: 

U:\rd\Bluebeam\Stamps 
 

Flattening Stamps  

At times it’s important to be able to flatten your stamps to prevent any deletion or modification after 
the document has left your hands. This can be accomplished by using the Flatten context menu 

option, or the Flatten Markups tool.  

Flatten Context Menu Option  

This option will flatten the selected markups.  

 •  Right-click on the markup and  

              then click           Flatten.  
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Adding Not For Construction Or Preliminary Stamp On Plans   

To place the Not For Construction Stamp on the plans click on Document > Pages              > 

Apply Stamp.  An Apply Stamp dialogue box opens. 

 

 

 

Click on the drop down box and select: 
Background_NotForConstructon.pdf 

Note: The same steps can be used to select and place 
the Preliminary Stamp. 

Check the Page Range (Defult is all pages).  Click OK. 

Flatten the PDF 

To remove the stamp markups from the Markup List  
you must Flatten the PDF.  Otherwise the stamp 
markups will show up as review comments. 

Click on Document >               Flatten.  The Flatten 
Markups dialogue box opens.  Then uncheck the 

Allow Markup Recovery (If Checked).  Click Assign 
Layer >Type Not For Construction (Type Preliminary if 
Preliminary Stamp) in the area provided. Click All 
Markups. Check the Page Range(Default is all 

pages).  Click on Flatten. Click on             Save in the 
Command Bar. 

The Stamp will be placed on the Layer “Not For 
Construction” on every sheet.  

The Not For Construction Stamp layer can be turned 
off and on by clicking the eye 

Under the Layers Tab 

The Not For Construction Stamp layer can be deleted  

by right clicking on                                  and selecting 

 Delete. Under the Layers Tab.                                                         
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Flatten Markups Tool  

The Flatten Markups tool can be found in the Document group of the Command Bar under the 
Flatten pull-down menu.  

 

The Flatten Markups dialog provides additional controls over how markups are flattened.  

It’s important to note that if the Allow Markup Recovery (Unflatten) option is checked, then flat-
tened markups will be able to be converted back into markups using the Unflatten tool. If your in-
tent is to prevent deletion or modification of your markups after handing off the PDF, then make 

sure that the Allow Markup Recovery (Unflatten) option is NOT checked.  

There are checkboxes to include the various markup types in the flattening operation, and there 
are also options to exclude the currently filtered markups to further refine what gets flattened.  
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Markups List  

The Markups list is a specialized tab with a horizontal layout that provides powerful features for 
processing, accessing, reviewing, and summarizing the markups on a PDF. By default it is found in 
the bottom panel.  

To access the Markups list, click            > Markups or press Alt+L.  

Markups List Button Bar  

The Markups list button bar contains tools for organizing, processing, importing and exporting data. 

 

Expand All: Expands the entire Markups list. 
  

Collapse All: Collapses the entire Markups list. 
  

Previous: Moves to the previous Markups in the list. 
  

Next: Moves to the next Markups in the list. 
  

Filter: Displays only markups that match the filter criteria. 
  

Clear Filters: Clears applied Filters. 
  

Hide Markups: Hides all markups in the current PDF file. Markups will not display or print when 
this mode is enabled. This mode is temporary and will be reset the next time that Revu is started.  
 

Search box: Filters based on the text entered in the box. 
  

Columns menu: Selects which columns to display in the Markups list. 
  

Manage Columns: Launches the Manage Columns dialog to change the display order and 
add, remove, and create custom columns. Columns can also be reordered by dragging and drop-
ping column headers.  
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Delete: Deletes currently selected markup or reply.  

NOTE: Delete removes the markup from the PDF, not just from the list.  
 

Reply: Replies to the selected markup. Replies appear on a new indented row below the 
markup in question.  

 

Status menu: Sets the status of the markups. The default states are the following: Accepted, 
Reject, Completed, Canceled, None.  

 

Manage Status: Creates and manages custom states.  
 

Checkmark menu: Checks or unchecks the checkbox associated with the selected markup. 
Also provides a command to clear all checkboxes.  

 

Import: Takes the markups from a PDF or an XML file and includes them in the active PDF. 
This is useful for incorporating and reviewing markups or feedback from multiple sources. FDF 
files containing markups generated from other PDF applications may also be imported.  

 

Export: Exports all markups to an XML file. The XML file can be imported into another PDF so 
that the markups will be displayed in the target PDF. The created XML file can also be imported 
into Microsoft Excel for viewing in a tabular form. Markups may also be exported to the FDF for-
mat for interoperability with other PDF applications.  

 

Summary: Provides a formatted list of all of the markups in the document. It is also 
possible to define a subset of markups to summarize.  

Markups List  

The Markups list displays a table, with each row representing a markup that has been added to 
the active PDF. Each column displays information about the markups.  

As a row is selected, the view of the PDF in the workspace will jump to the location of the associ-
ated markup. This makes it easy to use the markup list to step through the markups in PDF. To 

step through, click the Previous or Next buttons, or press the Up/Down arrow keys.  

Horizontal section separators with disclosure triangles show and hide each section of the Markups 
list. Click a disclosure triangle to show or hide that section.  
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The following figures show an expanded, collapsed and partially collapsed list that is sorted by 
Page number:  

Expanded List  

 

Collapsed List  

 

Partially Collapsed List  
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Columns Menu  

The Columns menu allows you to toggle on and off various columns. A column that is turned on 
will appear in the top row of the Markups list and will display a check box next to the name in the 
menu. Click a column name to turn it on or off. To sort by any column, click the column's name on 
the header. Click again to reverse the sort order.  

Subject: Displays an icon of the markup and text referring to the subject 
of the markup. By default, the text contains the name of the tool used to 
create the markup (Pen, Highlight, Callout, etc.). This text can be 

changed in the Subject field in the Properties tab, or by double-clicking 
on the Subject text in the Markups list.  

Page: Displays the name of the page on the PDF on which the markup 
is located.  

Page Index: Displays a numeric value indicating the page on which the 
markup or measurement resides. The Page Index is a useful column for 
sorting when exporting to spreadsheet programs.  

Lock: Toggles whether the markup is locked for editing or not. If locked, 

 a            appears in the box, and the markup cannot be moved or 
changed. If unlocked, the box is clear and the markup can be edited.  

Status: Can be set to one of the default states or a custom status. The 
default values are Accepted, Rejected, Canceled, Completed and 
None. Once the status is set on a markup, you can sort by status.  

Checkmark: Toggles the checkbox, enabling the Markups list to be 
used as a basic checklist. As changes are being reviewed, click to check 
the box; click again to uncheck it.  

Author: Indicates the username of who made the markup. Double-click 
this field to edit your displayed name. To set the name globally, click 
Settings > Preferences > General, then enter a name in the User box.  

Date: Displays the date and time the markup was modified based on the 
system time.  

Creation Date: Displays the date and time the markup was created based on the system time.  
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Color: Displays the fill color that was used for the markup. You may sort by this column to group 
all "red" or "blue" markups.  

X and Y: Display the coordinates on the PDF page where the markup is located, counted from the 
lower left.  

Width and Height: Display the size of the markup itself.  

Comments: Displays the comments from the General section of the Properties tab for this 
markup. Double click in this field to change the comment associated with the markup.  

Length, Area, Volume, Count, and Measurement: All display values associated with 
Measurement markups.  

Label: Displays the label associated with the markup. Label can be changed in the General 
section of the Properties tab. For measurement markups, it is common to use the Label field to 
specify the type of material that's being measured, such as "Asphalt Pavement 1" or "Conduit 3".  

Sequence: Records the numerical value associated with a Sequence markup.  

Layer: Displays the Layer the markup is associated with.  

Space: Displays the Space that contains the markup.  

3D View: Displays the 3D view that contains the markup. Click to jump to that view in the 3D 
window.  

Context Menu  

Right-click on any field in the markup list to display a context menu for 
performing functions on the currently selected cell. The first option, 
Copy, stores the contents of the cell on the clipboard, enabling the 
pasting of the information within Revu or other Windows applications.  
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Chapter 3: Document Manipulation  
The Document group provides commands and menus for working with the PDFs. The Pages 
menu contains commands for manipulating the actual pages of the PDF.  

  

 1.  Insert Pages – adds a blank 

                 page 

 2.  Extract Pages – removes or 

                copies one or more pages 

                from the document to a new 

                pdf 

 3.  Rotate Pages – Rotates one 

                or more pages in 90-degree 

                increments 

 4.  Crop Pages – reduces the 

                page size according to user 

                definition 

 

 

 

Insert  

To insert a page or pages use the Insert Pages command. Select Files. Choose where to place 
pages > Click OK  
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Extract  

Individual pages or a range of pages can be pulled 
out of the current document into a separate file or 
group of files using the Extract Pages command. 

 

 

 

 

 

 

 

  

Rotate  

To rotate the currently active page by 90°, use the 
Rotation toolbar. If you do not see the Rotation 
toolbar, click View > Toolbars > Rotation. 

 

 

 

 

 

  

Crop  

Bluebeam Revu includes a cropping tool 
that allows you to remove unwanted parts 
of a PDF page. Using the Crop Pages 
feature will modify the PDF file; therefore it 
is recommended that you make a copy of 
the PDF before proceeding.  
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Document Comparison  

The Compare Documents feature is used to compare two PDF files and highlight the differences. 
The differences are indicated with markups. Once the markups have been created, the differences 
can be reviewed using the Markups list.  

Comparing Two Versions of the Same Document or Drawing  

•On the Command Bar, click Document > 

Comparison >           Compare Documents...  
 

Defining Documents A and B  

 •  If the document is already loaded 

              within the current Revu session, click 

              the Document list in the Document 

              A section, then click the name of the 

              file. 

 •  If the document is not loaded,  

              Click                 
 

 •  In the Open dialog, locate the 

              appropriate file, then click Open. 

 •  Click the Page Range list to define a 

              range of pages to use for 

              comparison. 

Follow the same steps in the Document B 
section to define Document B.  
 

Optionally Defining a Region  

If you want to compare only a specific region of each document, click Select Window, then define 
a rectangle. Otherwise the entire document will be compared.  
 

Aligning the Documents  

By default Revu will attempt to line up the document. If you wish to override the automatic 

alignment, click Pick Points to specify the alignment points. You will need to pick 4 points on each 
document. The points should be specified in a clockwise order and the alignment points should 
correspond to one another; for example, Selection Point 1 on Document A should correspond to 
Selection Point 1 on Document B.  
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Defining the Appearance of Markups  

Click Advanced to change the markup 
appearance. Options include Color, Fill, 
Opacity, whether the markup has a cloud 
appearance, and if the markup should be 
locked when placed in the PDF.  

The Subject field can be used to name 
the difference markups (e.g., “Differences 
2-6-09”). You can then sort the Markups 
list based on Subject. All difference 
markups will be grouped together since each markup has the same subject. A series of difference 
comparisons can be made over time to provide a change history.  

The Apply to list determines to which document the markups are added when the comparison is 
run. The settings available are the New Copy of Document A, New Copy of Document B, Both Doc-
ument A and B, Document A Only, Document B Only. 
  

Choosing Other Options  

Check the Split-screen view box to open side-by-side synchronized windows for reviewing the dif-
ferences noted after the comparison process completes. Check Turn on Dimmer to dim underlying 
PDF content and make the locations where differences are found easier to see.  

 •  To run the comparison, click OK. 

Once the comparison completes, any differences will be annotated.  

If the Split-screen view box was checked, the two compared documents will open in a side-by-
side manner. Zooming or panning on one window will update the display in the opposite window. 
This is useful for visually comparing the before/after, changed, and unchanged parts of the two 
documents. The markups that were added will appear in either the left or right window depending 
on which PDF was specified.  

Open the Markups list to see a table of markups that were automatically added when differences 
were detected.  

As a markup is selected in the Markups list, the Revu workspace will jump to the location of the dif-
ference.  
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Creating a PDF from Multiple PDFs 

Multiple PDFs can be combined into a single PDF from within Revu or from the context (right-click)
menu in Windows Explorer. 

To combine multiple PDFs into a single PDF from within Revu: 

 1.  Go to File>        Combine. The Combine PDF Files dialog box appears.  

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 2.  Add files to the list: 

  O  To add all PDFs that are currently open in Revu, click Add Open Files. 

  O  To select files from a local or network drive, click Add. 
 

 3. In a Session Plan Review the following shall be included in the combined PDF for review: 

  1.  Session Cover Letter  Example U:\rd\Misc\Design\topic\Bluebeam Session Cover Letter 

  2.  Special Provision Checklist 

  3.  Special Provisions (If Provided) 

  4.  Plan Sections A-Z/Non-Section Plans 

  5.  Utility/Building Specifications    

  6.  Utility/Building Plans 

Note:  You may add the Utility Spec., Utility 
Plans, Building Spec. and Building Plans as a 
separate document(s) in the Session Review 
(See Adding Documents to a Session Review) 
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 4.  PDFs will be combined in the order in which they are sorted.  To change the sort order: 

  O Click              and select the desired sort option to sort the files automatically. 

  O Select a file you wish to move and click either           to move it up in the list or 

                                      to move it down in the list to reorder the files in the list manually. 

  O Select a file and click             to remove it from the list. 

 5.  Click OK. 

 6.  Save the Combined File for Plan Reviews as CountyPCN#.pdf 

                And place the file in the Project Folder under the File Folder 

                “Review”. 

Options:  

Include Bookmarks: Add any bookmarks from the selected PDF files (Check this Item).  

Include File Attachments: Add any file attachments from the selected PDF files. (Do not Check) 

Merge Document Properties: Combine the document properties of the existing and selected PDF 
files. (Do not Check) 

Merge Layers: All layer information in the PDFs will be kept when this option is checked. If 
unchecked, the layers will be removed, but the content and markups in the layers will remain in the 
combined PDF. (Check this item) 

Use Filename as Page Label: By default, each page label of the combined PDF is named after 
the source PDF's page label. Select this to use the file names instead. (Do not Check) 

Creating a PDF From an Existing File Not a PDF 

Revu lets you create PDFs out of existing files, including those that are not PDFs themselves.  
When creating a single PDF out of a single not-PDF file, Revu will use its own plugin whenever 
available (for example, the Office or CAD plugins).   

 

 

 

 1.  Go to File >        Create >        From File.  The Open File 

                dialog box appears. 

 2  Navigate to and select a file.  The source file can be a document, such as a Word, Excel 

              or PowerPoint document.  Once the file is selected, click Open.  The Save As dialog box 

              appears. 

 3.  By default, the PDF created out of the selected file will have the same name.  If desired, 

               enter a new name in the File name field, then choose a folder location and click Save. 



 2. Navigate to and select a file.  The source file 

               can be a document, such as a Word, Excel 

               or PowerPoint document.  Once the file is 

               selected, click Open.  The Save As dialog 

               box appears. 

 3.  By default, the PDF created out of the 

                selected file will have the same name.  If  

                desired, enter a new name in the File name 

                field, then choose a folder location and click 

                Save. 

 

 

 

 

 

Creating a PDF(s) From Multiple Existing Files Not PDFs 

Revu lets you create PDF(s) out of multiple existing files, including those that are not PDFs 
themselves.   

 1.  Go to File >        Create >           From Multiple Files.  The  

                  Open File dialog box appears. 
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 2  Navigate to and select the files.  The 

               source files can be a document, such as 

               a Word, Excel or PowerPoint document. 

               Once the files are selected, click Open.  

               The Stapler                   dialog box 

                appears. 

 3.  If you are going to combine the files use 

                the             to change the order of the files.   

   4.  Select if One Output File is desired or 

                One Output File Per Document. If one  

                 output file is desired then provide a 

                 name for the file.             

 5.  Pick the Output Folder 

 6.  Click OK 

 7.  The Stapler  - Untitled Job dialog box 

                appears. 

 8.  Select the Staple button and the files will 

                be converted to PDF and opened.  
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Stapler Using Windows Explorer to Combine or Convert Files 

Windows Explorer Context (right-click) menu  

In Windows Explorer, you are able to select files and 
right-click to Combine Files or Convert Files in Revu 
using Stapler.  

Step 1: Browse in Windows Explorer to a folder  

             containing the files you want to Convert or 

             Combine.  

Step 2: Select the files in the Explorer window.  

Step 3: Right-click on any of the selected files and 
choose Combine Files in Revu or Convert Files 

             in Revu.  

Combine Files in Revu will create a single multipage PDF from the selected files.  

Convert Files in Revu will make individual PDF from each of the selected files.  

1.When Combine Files in Revu is selected, 
(File>Stapler will be invoked with the files chosen 
already populated in the source file window. 

2.Enter the name of the Output File. 

3.Change the Custom Output Folder if needed. 

1.When Convert Files in Revu is selected, 
Stapler will be invoked with the files chosen 
already populated in dialog. 

2.Select the Staple button and the files will be 
converted to PDF and opened in Revu.  

 

 60 



Add SDDOT Header and Footer Templates 

The following SDDOT Header and Footer Templates need to be saved into the software: 

This can be done by either of the following: 

 1. By clicking on the Bluebeam Profile file U:\rd\Bluebeam\Profile 

 2. By Manually entering the Templates as shown below. 

Open a PDF then Go to Document >             Headers & Footers > Add. The Header and Footer 
dialog box appears. 
 

Title Block (Plans 11x17) 

Template 1 -  Title Block (Plans 11x17) 

Font  -  Arial 8 

Top Margin  -  0.68 

Bottom  -  0.50 

Left Margin  -  14.20 

Right Margin  -  0.65 

Right Header Text  -  B<<1>>      B99 
 

Title Block ( Cross Sections 11x17 Portrait) 

Template  2  -  TB Cross Sec Portrait 

Font  -  Arial 8 

Top Margin  -  0.50 

Bottom Margin  -  0.42 

Left Margin  -  8.70 

Right Margin  -  0.40 

Right Footer Text  -  X<<1>>      X99 
 

Title Block (Cross Sections 11x17 
Landscape) 

Template  3  -  TB Cross Sec Landscape 

Font  -  Arial 8 

Top Margin  -  0.60 

Bottom Margin  -  0.50 

Left Margin  -  14.20 

Right Margin  -  0.40 

Right Header Text  -  X<<1>>      X99 

Enter each one of the Header & Footer Templates infor-
mation and name the Template as shown.  Make sure you 
save the Template.  When you are done you should have 

3 Templates when you click on the down arrow by Save 
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Numbering PDF Pages Using Headers and Footers for SDDOT Plans 

Open the Document Group 

 

 

 

Click the main button to open the Header and Footer dialog box, from which you 
can add a new header and/or footer (if none currently exist on the page) or edit the 
current header and/or footer. Click the arrow to the right to invoke the Headers & 
Footers menu. 

Add: Adds a new header and/or footer to the document. 

Edit: Edits the document's existing header and/or footer. 

1. Go to Document >             Headers & Footers > Add. The Header and Footer dialog box 
appears. 

For SDDOT Plan Sheets: Use a previously configured header/footer template, select the Title 
Block (Pans 11x17) template from the Save Settings list.  

2. Under “Right Header Text” Change 
the first “B” to the appropriate 
section.  (DO NOT change <<1>>). 

 Change the second “B” and “99” 

           to the appropriate section and the 

           total number of pages. 

3. Project Number 

 Under “Left Header Text” fill in 

           Project Number. 

4. Click on Batch Page Range X-X.  The 

    Batch: Header & Footer dialogue box 

    opens.  See next page. 

Note:  For SDDOT Cross Section 
Portrait Sheets and Cross Section 
Landscape Sheets specific 
requirements refer to page 64. 
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Click OK 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click OK 
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For Cross Section Portrait sheets: Refer to Page 63 for general instructions  

All pages will need to be rotated so the title block is right side up. 

Select “TB Cross Sec Portrait”.  Under “Right Footer Text” change the first “X” to the appropriate section. 
(DO NOT change <<1>>).  Change the second “X” and “99” to the appropriate section and the total number 
of pages. 

Optional - Project Number.  Under “Left Footer Text” fill in Project Number.  Select “ Page Range Op-
tions…” and set the range of pages to modify.  Adjust “Start Page Number” under “Page Number and Date 
Format…” for the pages to update. 

Select OK. 

For Cross Section Landscape sheets: Refer to Page 63 for general instruc-
tions  

Select “TB Cross Sec Landscape”.  Under “Right Header Text” change the first “X” to the appropriate sec-
tion. (DO NOT change <<1>>).  Change the second “X” and “99” to the appropriate section and the total 
number of pages. 

Optional - Project Number.  Under “Left Header Text” fill in Project Number.  Select “ Page Range Op-
tions…” and set the range of pages to modify.  Select “Page Number and Date Format…”  and modify 
“Start Page Number” to define the starting page number. 

Select OK.  
 

Note: 

 This applies page numbers and total pages to all the pages in the PDF (unless you specify some-
thing different).  If all the pages don’t have the title block in exactly the same location those pages 
will need to be adjusted.  One solution is to fill in the numbers in the source software. Or you can 
update the Header & Footer and apply it only to the pages selected in the Page Range Options.  
You will also want to adjust the “Start Page Number”. 

Note: 

 The “Right Header Text” is right justified text and controlled by the “Right Margin” setting. 

    The “Left Header Text” is left justified text and is controlled by the “Left Margin” setting. 

    To move the Project Number left or right adjust the Left Margin. 

    To move Total Page Number left or right adjust the Right Margin. 

    To move Page Number left or right adjust the number of spaces after <<1>>. 
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Numbering PDF Pages Using Batch Processing -  Headers and Footers   

 

 

 

 

1. Go to File >             Batch >             Headers & Footers. The Batch: 
Header and Footer dialog box appears 

2.  Add documents using one (or both) of the following methods: 

 O  To add all PDFs that are currently open in Revu, click Add 

              Open Files. 

 O  To select files from a local or network drive, click Add. 

3. Click OK.  The Header and Footer dialog box appears.  See next 

      page. 
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4. Use a previously configured header/ 

      footer template, select the Title Block 

      (Pans 11x17) template from the Save 

       Settings list.  

5.  Under “Right Header Text” 

 Change the first “B” to the 

           appropriate section.  (DO NOT 

           change  <<1>>). 

 Change the second “B” and “99” to 

           the appropriate section and the total 

           number of pages. 

6.  Project Number 

 Under “Left Header Text” fill in 

           Project Number. 
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Batch Removing Headers and Footers 

This process describes removing all headers and footers from multiple documents. To remove just 
a header or a footer or just a part of either, process the PDFs individually as described in Editing 
Headers and Footers. 

To remove all headers and footers from multiple documents: 

1. Go to File >               Batch >          Headers & Footers. The Batch: Header and Footer dialog box 
appears. 

2. Add documents using one (or both) 

     of the following methods: 

 O  To add all PDFs that are 

               currently open in Revu, click 

               Add Open Files. 

 O  To select files from a local or 

               network drive, click Add. 

3. To remove headers/footers from 

      specific pages of a PDF, select it, 

      then click the Pages menu and 

      choose from the following: 

 O  All Pages: Sets the range to all 

              pages. 

 O  Custom: Sets the range to a custom value. When this option is selected the list becomes a 

              text box. To enter a custom range:  

  O  Use a dash between page numbers to define those two pages and all pages in 

                         between. 

  O  Use a comma to define pages that are separated. 

  For example: 1-3, 5, 9 will include pages 1, 2, 3, 5 and 9. 

4. From the Apply To menus, select among Even Pages Only, Odd Pages Only or Odd and Even 

     Pages and among Landscape Pages, Portrait Pages or Landscape and Portrait Pages. These 

     selections work in conjunction to form the filter, so any pages to be processed must meet both 

     criteria selected. 

5.  Click OK. The Header and Footer dialog box appears.  See next page. 
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6. Click Delete All. A warning dialog box appears. 

 

 

 

 

 

 

 

7.  Click OK 
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Editing Page Labels and Page Numbering 

 

To change the name of a page label directly 

1. Select the Thumbnails tab. If it is currently hidden, go to View >          Tabs >        Thumbnails 

     or press ALT+T. 

2. Select the thumbnail and press the F2 key. The thumbnail's label becomes editable. 

     Alternatively, double-click the thumbnail's page label. The thumbnail's label becomes editable. 

     When in this mode, pressing TAB will move to the next page label while remaining in Edit mode. 

     Pressing SHIFT+TAB will move to the previous page label. 

 

To edit a page label’s numbering style 

1.  Select the Thumbnails tab. If it is currently hidden, go to View > Tabs > Thumbnails or press 
ALT+T. 

2.  Use one of the following methods to open the Page Numbering and Labeling dialog box:  

 O  Select the thumbnail and go to Document > Pages >  Number Pages. 

 O  Select the thumbnail and go to  Options > Number Pages. 

 O  Right-click a thumbnail and select Number Pages. 
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3.  Set or change any of the following options, as desired:  

 O  Style: Select a numeral style for the page label. 

 O  Prefix: Enter a value (for example, "Page ") that will precede the page label's numeral.  

  O  To insert a space between the Prefix and the numeral, add a blank space at the 

                         end of the Prefix. 

 

 O  Start: Sets the starting numeral. 

 O  Page Range: Determines which pages will be affected by the settings. Select one of the 

              following: 

  O  All Pages: Sets the range to all pages. 

  O  Current: Sets the range to the current page only. The current page number will 

                         appear in parentheses, for example, Current (2) if page 2 is the current page. 

  O  Selected: Sets the range to the current selection. This option only appears if pages 

                         were selected prior to invoking the command. 

  O  Custom: Sets the range to a custom value. When this option is selected the list 

                         becomes a text box. To enter a custom range:  

   O  Use a dash between page numbers to define those two pages and all pages 

                                    in between. 

   O  Use a comma to define pages that are separated. 

   O  For example: 1-3, 5, 9 will include pages 1, 2, 3, 5 and 9. 

4. Click OK. 

To apply a text only label 

Follow the procedure outlined in To edit a page label's numbering style above and set the following 
options on the Page Numbering and Labeling dialog box: 

 Style = None. 

 Prefix = desired text label. 

To remove page labels 

Follow the procedure outlined in To edit a page label's numbering style above and set the following 
options on the Page Numbering and Labeling dialog box: 

Style = None. 

Prefix = blank. 
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Creating Page Labels from Page Regions 

1. From the Thumbnails toolbar, click             Create Page Label. The Create Page Labels dialog box 
opens. 

2.  Select Page Region. 

3. Click Select. The Create Page Labels dialog box disappears, replaced with a crosshair cursor. 

4.  Click and drag to define a region on the PDF. Generally 

     speaking, the data in this region should be consistent 

     across any PDFs being labeled. When the region has been 

     defined, the AutoMark dialog box opens. 

5. To add another region, click Add. The AutoMark dialog 

       box disappears, replaced with a crosshair cursor again. 

       Click and drag to define another region. The AutoMark dialog box reappears with the new region added 

        to the Selection field. There is no limit to the number of regions that can be added.  

 O  Review the sample page label as shown under Preview. If desired, click in the Selection field to 

               add text before, after or between [Regions]. 

6. When all regions have been defined, click OK. The AutoMark dialog box closes, 
replaced by the Create Page Labels dialog box. 

7.  Select a Page Range: 

 O  All Pages: Sets the range to all pages. 

 O  Current: Sets the range to the current page only. 

               The current page number will appear in parentheses, 

                for example, Current (2) if page 2 is the 

                current page. 

 O  Selected: Sets the range to the current selection. This option only appears if pages were selected 

               prior to invoking the command. 

 O  Custom: Sets the range to a custom value. When this option is selected the list becomes a text 

                box. To enter a custom range:  

  O  Use a dash between page numbers to define those two pages and all pages in between. 

  O  Use a comma to define pages that are 

                           separated. 

  For example: 1-3, 5, 9 will include pages 1, 2, 3, 5 

                        and 9. 

Click OK. 



Introduction to OCR in Revu 

Optical Character Recognition (OCR), or text recognition, translates the text in scanned PDF 
documents into searchable text. Once OCR has been run on a scanned PDF, you can search the 
document for specific text, add bookmarks and hyperlinks on text, copy text to another document 
or use one of Revu's advanced text editing tools. 
 

Note: Do Not run OCR on all SDDOT plan sheets.  Run OCR only on pages with images.  
Some pages that may need OCR are Note Sheets, Quantity Sheets and Data Sheets.  These 
requirements may change as we test the new OCR in the 2016 version of Bluebeam Revu 

Running OCR on a Single Document 
 

1. Open the document on which OCR is to be run. 

 

2. From the Command bar, go to Document >                OCR or use the keyboard shortcut 

      Ctrl+Shift+O. The OCR dialog box opens. 

3. Set the OCR Configuration options, as desired: 

 O  Correct Skew: Enable to correct angular deviations in scanned documents. 

 O  Detect Orientation: Enable to detect the page orientation (90, 180 and 270 degrees) of 

               each page and correct it if needed. 

 O  Detect Text in Pictures and Drawings: 
Enable to detect text in graphics. 

 O  Rotate Markups: If Correct Skew is 
enabled, use this option to also adjust existing 

               markups so they line up with skew- 

               corrected text or images. 

 O  Skip Vector Pages: Enable to skip 

              processing of pages with vector content. 

 O  Page Chunk Size: Use to determine the 

               maximum number of pages sent to the 

               OCR engine at one time. Increasing chunk 

               size can increase speed, but will also 

               consume more of the computer's 

               resources. 
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 O  Max Vector Size: Use to set the maximum vector size that will be analyzed during the 

              OCR process; any vectors larger than this setting will be discarded in pre-processing. 

              Decreasing this value can increase speed, but might also cause larger text (for example, 

              larger fonts) to be inadvertently ignored. 

 O  Optimize for: Use to optimize the OCR process for the selected document type. The 

              CAD Drawing setting tends to ignore text formatting, for example, while the Text  

              Document setting does not. 

4.  To select a Page Range, click the Pages menu and select from the following: 

 O  All Pages: Sets the range to all pages. 

 O  Current: Sets the range to the current page only. The current page number will appear in 

               parentheses, for example, Current (2) if page 2 is the current page. 

 O  Selected: Sets the range to the current selection. This option only appears if pages were 

              selected prior to invoking the command. 

 O  Custom: Sets the range to a custom value. When this option is selected the list becomes 

              a text box. To enter a custom range: 

  O  Use a dash between page numbers to define those two pages and all pages in 

                         between. 

  O  Use a comma to define pages that are separated.  

  O  For example: 1-3, 5, 9 will include pages 1, 2, 3, 5 and 9. 

6. Click OK to run OCR. 

7.  Save the Document. 
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Running OCR on Multiple Documents (Batch) 
 

1. From the Command bar, go to File >               Batch >              OCR. The Batch: OCR 

dialog box opens. 

 

2. Add documents using one (or 

    both) of the following methods: 

 O  Click Add Open Files to 

              add currently open files to 

              the list. 

 O  Click Add to select files 

              from a local or network 

              drive to the list. 

3. To select a Page Range, click 

    the Pages menu and select from 

    the following: 

 O  All Pages: Sets the range 

              to all pages. 

 O  Custom: Sets the range to a custom value. When this option is selected the 

              list becomes a text box. To enter a custom range: 

  O  Use a dash between page numbers to define those two pages and all pages in 

                         between. 

  O  Use a comma to define pages that are separated. 

  For example: 1-3, 5, 9 will include pages 1, 2, 3, 5 and 9. 

4. Click the Apply To lists to select among Even Pages Only, Odd Pages Only or Odd and Even 

    Pages and among Landscape Pages, Portrait Pages or Landscape and Portrait Pages. 

5. Select the next PDF in the File List and repeat steps 3 and 4 until Page Range and Page Filter 

    options have been set for each PDF. 

6. Click OK. The OCR dialog box opens. See settings for single document OCR. 

7. Click OK to run OCR 
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Chapter 4: Studio Session  
Studio Session: Create, share and collaborate in the cloud  

Studio combines the best of cloud storage and collaboration. Simply upload your PDFs to a Stu-
dio session, and invite attendees from around the world to view and add markups to the same 
PDFs in real-time or on their own time. All session activity is tracked in a record that conveniently 
links back to the PDFs. You can even create reports to archive or share with your team.  

 

Host a Studio Session  

The session host is the person who starts and controls the Studio Session. The host starts the 
session, adds the documents, invites the attendees and defines the security and permissions. 
The host also manages the Session. Documents can be added or removed and new attendees 
invited. When everyone has contributed, the host also creates the report, finishes the session and 
saves the files.  

However, the host does not need to be in the session for other people to join the session and 
work. People work at different times and have different times available to them for different types 
of work. Once a session is started, anyone who has been invited can login to the session and 
work.  

The features available to attendees when attending a session have already been described. This 
section addresses the features that are unique to the Host.  
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Start a Session  

To start a new Session:  

 •  In the Studio tab button bar, click          Start >  

              New Session. 

 •  The Create Studio Account dialog displays if you 

              have not already created an account. If you have an 

              existing account you can log in with your existing 

              account.   

 •  The Start Studio Session dialog displays. 

 •  Session Name: Use CountyPCN# Review Due Date Time  Ex. Minn025C 08-15-16 5 PM  

              The date and time allows the reviewers to see the due date and time in the email without opening 

               the plan review.   The Date and Time in the name also allows the reviewers to know at a glance in 

               the Studio Session List when the review comments are due especially for the reviewers that have 

               multiple Session Reviews to keep track of. 

 •  Click Add to select PDF documents that you want to be part of the session, or click Add 

              Open Files to add the files that are already open.  For Plan Reviews use a combined PDF 

               file of all Sections including the Cover Letter, Check List and any Special Provisions 

               available. Separate documents can be added in the Session Review for the Utility Spec./Plans or 

               Building Spec./Plans.  Example of a Cover Letter can be found here: 

               U:\rd\Bluebeam\Session Cover Letter 

 Options: 

             Select the Permissions. You can allow or disallow 

             attendees to Save, Print or Markup the PDF 

             documents that are in the session and include the 

             ability to Add Documents to the session. For Plan 

             Reviews Check Save As, Print, Markup and Markup 

             Alert. 

   Check Restrict Attendees by E-mail Address if 

              you want to restrict access to the session by e-mail  

              address. 

             IMPORTANT - In Plan Reviews leave The  

             Restrict Attendees unchecked to allow users that 

              have been forwarded the e-mail invite to join the 

              session. 



 •  Check Session Expires if you want to have an end date for the Session. For Plan Reviews 

               always check this to have an end date for the review and modify the time 

               (Recommend 5:00 PM). 

 •  Click OK to save the settings and upload the files. The Session Invitation dialog displays. 

 •  The Session Information is listed at the top of the dialog. Click the Copy Invitation button to copy 

                the session Invitation information to paste it into another program, such as an e-mail message, IM  

                or document.  

 •  The Invitees section allows you to add e-mail addresses so you can send the information needed 

                to join the session. This list of e-mail addresses also defines who is allowed to access the session 

                if Restrict Attendees by E-mail Address was selected. 

               Click on Address Book to bring up the Outlook email list. Add the people that are needed for the 

               Plan Review including FHWA (If project is an oversite project), Local Governments, Consultants 

               and SDDOT Designers. 

 •  Click            to add a new email address.  Type the E-mail address and click OK. 

 •  Select an email and click           to change an email address. 

 •  Click         to remove an email from the list. 

 •  Click             to add all members of an existing Group. 

 •  Type a Message. For a Plan Review 

               always include the Project Description in 

               this Message Area (Copy and Paste from 

               Letter).  Also include that it is a Plan 

               Review and the due date and time. 

               This Message is included in the email 

                invitation that is sent out. 

              •  Click OK when you are done and the 

              email invitations will be sent from the 

              Studio server. 

Note: the email invite can be forwarded to any person 
that needs to take part in the review. They will need 
the free version of Bluebeam Vu to do the review. 
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 •  Address Book will open the address book of your e-mail program so you can select 

              people directly from your existing e-mail contacts.  This will bring up the Outlook email list. 

 •  E-mail Templates allows you create or access templates defined in Revu. 

  Note: The e-mail messages are sent from the Studio server.  

Manage a Session  

Documents, Attendees and Permissions can be added or removed during a session.   

Attendee Access  

Changes to the Attendees can be made during a session. Invitations can be sent to new 
Attendees. New Attendees can be granted access or Attendees can be denied access.  

Add Attendees to a Session  

(Invite Attendee)  

 •  Click           Invite at the top of the Attendees 

              section. 

 •  The Session Invitation dialog displays. 

Allow or Deny an Attendee  

There are three ways to deny an Attendee access to the 
session:  

 •  Right-click on the name in the Attendees list 

              and click Deny. 

   - or - 

 •  Click        Attendee Access in the Attendees 

              list. The Attendee Access dialog will display. 

 •  Select the name in the list and click Deny. 

   - or - 

 •  Click          Session Settings, then click the Attendees tab. 

 •  Select the name in the list and click Deny. 

An Attendee can be allowed back into the session after they have been denied access. Follow any 
of the steps above and click Allow.  

Note:  In SDDOT Plan Reviews the Allow or Deny option will not be used. 

 78 



 79 

Restrict Attendees by E-mail Address allows 
access to only those who appear in the 
Attendees list in the Attendees tab or Attendee 
Access dialog.  

 •  Click         Attendee Access in the 

              Attendees list. The Attendee 

              Access dialog will display. 

 •  Check Restrict Attendees by  

               E-mail Address and click OK. 

   - or - 

 •  Click           Session Settings, then click the Attendees tab. 

 •  Check Restrict Attendees by E-mail Address and click OK. 

NOTE: Restricting Attendees will not allow forwarding of the plan review email invite. 

Manage Documents  

Documents are added when a session is started, but the Host can also add, delete and replace 
documents during the session.  

See the Start a Session topic to add the documents when you start the session.  

Add a File:  

 •  Click           Add File in the Documents list. 

 •  Select the file or files and click Open. 

 

 

If a Section of the plans were not included in the Combined PDF it can be added to 
the  Review Session.  There will be a record of when the Section of plans was added 

to the review Session.  To notify the reviewers that the additional Section was 
added to the review an email shall be sent out to all reviewers using Outlook.  

Delete a File: Only the Host can delete a Session file.  Do not delete a Session 
Review Document unless absolutely necessary - All Comments will be lost. 

 •  Right-click on the name in the Document section and then click Delete. 

  

 



Responses To Review Comments and Revisions 

When the review period ends review comments can no longer be published to the review Session. 
The Project Manager will need to notify the Consultants/designers from each section that the 
review has ended and responses to the comments and revisions are to be completed by a certain 
date. All review comment responses shall be shown in the review Session. In order for the 
Consultants/designers to respond to the comments on the review Session the review deadline will 
need to be extended by the Project Manager (Host).  

Click on                        in the Studio Session. A  

Session Setting dialogue box will appear.  Uncheck 
the Expiration date to allow responses to the review 
comments. The Project Manager will set the 
Review Responses/Revisions due date in an email 
as shown on page 82.   Note: the reason that the 
Expiration date is not reset is because all of the 
attendees of the review will receive automatic 
emails that their comments are due by the new 
date. 

 

Next the Project Manager is required to set the 
Permissions on the review so that late review 
comments are not received.   

1. In the Session Settings click on Permissions. 

     In the Permissions window click on the 

     Attendees applied permissions “Markup” a arrow 

     will appear then select “Deny”. 

     The Attendees should have the following  

      permissions during the Review Response/ 

      Revisions period: 

 Save As  -  Allow 

 Print  -  Allow 

 Markup  -  Deny 

 Markup Alert  -  Allow 

 Add Documents   -  Deny 

 Full Control  -  Deny  
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2. The Project Manager is required to give 

      the Consultants/Designers permissions  

      to make the responses to the comments. 

      Click on          a list of the names of  

      the review attendees will appear.  Since  

      the Consultants/Designers were part of  

      the review their names should be on this 

      list. Using the Ctrl button on the keyboard 

      and mouse you can select multiple  

      names from the list.   Set the permissions 

      for each Consultant/Designer to the 

      following: 

 Save As  -  Allow 

 Print  -  Allow 

 Markup  -  Allow 

 Markup Alert  -  Allow 

 Add Documents  -  Deny 

 Full Control  - Deny 

       Click OK 

With the Permissions set for the Attendees/
Reviewers they will now be able to view the 
plans if they receive review comment 
rejection notices but will not be able to make 
any changes or additional comments.  Only 
the Consultants/Designers will be able to set 
the status and add their responses to the 
comments. 

Note:  If Reviewers want to contest the 
rejected comments they can send the 
Consultant/Designer that rejected the 
comment an email by right mouse button 
clicking on the Consultant/Designer name in 
the attendee list (upper right corner of the 
screen) then select E-mail.  The Project 
Manager shall be included in the email. 
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An email shall be sent out to all Consultants/
designers of the plans to notify them that the 
responses/revisions are needed by a required 
date.   

To create the email follow these steps: 

1. Click on           in the Session Attendees.  The 

      Session Invitation dialogue box opens.   

      Click on                             then open a new 

      email in Outlook.   

2. Right Click in the body of the email and paste the link 

      information of the Session into the email. 

3. Type in the message “The Review session for  

      CountyPCN# has ended.  In order for you to make  

      your responses and complete your revisions the  

      Review Session has been extended to “Date” “Time”.  

      Please send and email providing the location of your  

      final plans. 

4. Type in the Subject line “Provide responses/revisions  

      for CountyPCN# by “Date”. 
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Responses To Review Comments and Revisions Continued 

Statuses are useful for keeping track of comments and letting review participants know how you are 
going to handle the comments. Each Consultant/designer that are responsible for responding to the 
comment shall set the status of their part of the comment. The review status appears in the Markup 
List along with the name of the designer setting the status. If more than one designer sets the re-
view status for the comment, both names and review statuses appear in the comment. 

Select the comment in the comments list and right-click to show the options menu. Then choose an 
option from the Set Status menu. If the designer has complied with the changes requested by the 
comment the option would be “Completed”. The Status “Completed” can be both the Status and the 
Reply when the comment is totally complied with. If the designer has not complied with the changes 
requested by the comments the option would be “Rejected”. If the comment is rejected then the 
Consultant/designer shall explain why it was rejected by Replying to the Comment. With a Filter of 
the comments for the word “Rejected” the Project Managers and reviewers can see the comments 
not complied with.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Any Consultant/Designer that rejects a comment shall Alert the person that made the review 
comment and the Project Manager with their Reply to notify the reviewer. The Project Man-
ager shall confirm that all comments have been given a status and if the comment has been 
rejected an Alert has been sent to the reviewer. All Alerts are recorded and will become a 
part of the Session Report. 
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Rejecting comments, Replying to the Rejected Comments and Alerting the 
Reviewers that made the comments 

In the Markup List if you set the Status of a comment to “Rejected” the Consultant/Designer shall 
first reply to the rejected comments by right clicking on the comments and giving the reasons for 
the rejection.  Then the Consultant/Designer shall Alert the Reviewer and Project Manager by 
selecting both the Rejected Status and 
the reply in the Markup List and then right 
clicking on the selected comments.   

Then click on Alert Attendee and select 
the reviewers name and the Project 
Manager. 
 

An email will automatically be sent to the 
reviewer and Project Manager with a 
picture of the review comment and the 
response.  Hyperlinks in the email will 
take the reviewer to the exact location of 
the comment and response in the plan 
review.   
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Completed Review Session Report 

Note:  Before creating the Session Report the Project Manager shall verify that all Rejected 
Comments have a corresponding Alert record or e-mail that the reviewer was notified of the 
rejected comment. 

After the plan review and responses are complete the SDDOT Project Manager shall generate a 
Session Report that has a record of all activity and comments/responses.   

 

 

Click          Report in the Record Section of the Studio tab. 

Click PDF Package Report which creates a PDF package containing the Record Summary and all 
of the documents in the session with the review comments and responses. 

 

The PDF Package Report contain 
hyperlinks in the Record Summary that 
link to the corresponding markup in the 
document. 

The Title of the Session Report shall be 
CountyPCN#_archive. 

Ex. Minn025C_archive 

Notes, If needed, will be included at the 
top of the Session Report. 

Select the Page Size (Letter) 

Include the Attendees List 

Include the Documents List 

Include Filtered Record Items 

In the Columns Box Check: Date, Time, 
Document and Page. 

Click OK to create the Session Report. 

Place this file in your project folder under 
Review.  

A copy of the PDF Package Report shall be sent to the Consultants for their records using the DOT 
FTP Site or using the “Projects Folder” in Bluebeam Revu. 
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Finish a Session 

Finish the Session ends the session and removes the documents from the Studio server. The 
Finish Session dialog lets you create the Session Report and select how you want to save or 
discard the documents. Before the Project Manager Finishes the Session for the project they 
shall verify that the PDF Package Session Report CountPCN#_archive was already created 
and stored under the Project “Review” folder.  Since the PDF Package Report contains the 
Session Report and all of the documents with comments and responses that were included in the 
Plan Review Session the Session files do not need to be saved and the Session does not need to 
be generated with the Finish Session process. 
 

•  Click         Finish in the Studio button bar and the Finish Session dialog displays. 

 •  Include Markups: All reviewers will be selected by default. 

 •  Save Options: 

  O  Click Do not save files: A Session 

                         Report has already been created with 

                         all files attached. 

                     O  UnCheck Generate Report. A  

                         Session Report has already been 

                         created. 

  O  Click OK to Finish the Session.  

Note: The Session and all of its files are removed 
from the Studio server when the session is 
finished. To gain access to a session that you 
have already completed, go to https://
studio.bluebeam.com  
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Memorandum/Le er to Bid Le ng  

Since all of the review responses are included in the Session Report a review response le er is not required. 

A hyperlink to the Session Report of the review PDF in the memorandum/le er is all that is needed. See 

example of this Memorandum at this link: U:\ms\Misc\Acrobat Pro X Electronic Review\Memorandum to 

Bid Le ng.doc The Project Manager shall send this memorandum to the Bid Le ng Office and copied to 

the field offices (Region Engineer, Region Opera ons Engineer, Region Traffic Control Engineer, Region 

Designer, Area Engineer and Area Engineering Supervisor), all reviewers as listed in the Session Report, 

FHWA and any Local Government Offices. This memorandum shall have a link to the Session Report and a 

link to the final plans that go to Bid Le ng. If FHWA or Local Government Offices are involved then a link to 

those files on the FTP site needs to be included. The field offices and reviewers will then have an opportuni‐

ty to compare the review responses to the final plans to see if their comments were addressed at an early 

stage of the bid le ng process vs. when they receive their copies of the plans/proposals for construc on 

from Project Development.  
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Appendix 
 
 
Electronic PDF Plans        
 

This documentation assumes: 

PDF Software Used — Bluebeam Revu Extreme 

 

Naming Convention: 

 

            Note: Each Addendum or CCO includes only the revised sheet(s) for that Section. 

 

Original File Location: Office’s prj folder (Ex. U:\rd\prj\CNTYPCN#\  for Road Design) 

Page Size:    Match Paper Size (8.5 in. x 11 in. or 11 in. x 17 in) 

Rotation:   Match Paper (Landscape or Portrait) 

Color:   Match Paper (One set matching Bid Letting Submittal) 

Resolution:   600dpi 

Number pages to match Section in PDF (Ex. B for Section B) 

 

File size of PDFs usually is between 100 KB to 300 KB per page. Rarely should it exceed 
500 KB per page. Large files can cause performance issues viewing and printing.  
 

Document Untitled Viewports Message 

If you receive this message when opening a PDF in BlueBeam Revu check the “Do not show this 
message again” and click on No. 

    Addendum CCO 

Section Method PCN#_Section?.pdf PCN#_Section?
Add#.pdf 

PCN#_Section?
CCO#.pdf 

Non-Section 
Method 

PCN#_Nonsection.
pdf 

PCN#_NonsectionA
dd#.pdf 

PCN#_NonsectionC
CO#.pdf 

    Addendum CCO 

Section Method PCN#_Section?.pdf PCN#_Section?
Add#.pdf 

PCN#_Section?
CCO#.pdf 

Non-Section 
Method 

PCN#_Nonsection.
pdf 

PCN#_NonsectionA
dd#.pdf 

PCN#_NonsectionC
CO#.pdf 
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PDF from Word or Excel with Bluebeam Revu  
Open file  

File>Print 

Select Bluebeam PDF as the printer  

Note: If the file is Color but Black and White is desired: 

Click on Print Print Properties > Paper/Quality 

 Color: Select Black & White 

OK 

Click on Print>Select folder to save PDF 

Verify Print options  

Click on Save  
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Adding “Not For Construction” as a Stamp 
 Refer to pages 44 and 45 of this manual to add “Not For Construction” to the plans. 

 

Removing the Stamp “Not For Construction”  
 Refer to page 45 of this manual to remove “Not For Construction” Stamp from the plans. 

 

Adding “Preliminary” as a Stamp (ROW Plans – Only) 
 Refer to pages 44 and 45 of this manual to add “Preliminary” to the plans. 

 

Removing the Stamp “Preliminary” (ROW Plans – Only) 
 Refer to page 45 of this manual to remove “Preliminary” Stamp from the plans. 

 

Numbering PDF Pages using Header and Footers 
 Refer to pages 61 to 68 for Numbering PDF Pages using Header and Footers 

 For Plan Sheets use Template  -  Title Block (Plans 11x17) 

 For Title Block (Cross Sections 11x17 Portrait) use template  -  TB Cross Sec Portrait 

 For Title Block (Cross Sections 11x17 Landscape) use template  -  TB Cross Sec 
 Landscape 
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Standard Plates in Bluebeam Revu 11x17 sheets 
If you have MicroStation V8i it is recommend you use MicroStation for this procedure. 

 

Download Standard Plates needed from the Office of Road Design’s WEB page (http://
www.sddot.com/business/design/plates/Default.aspx ). 

Right Click on Standard Plate Number > Save Target As… 

Note: Standard Plates are also stored at U:\pd\Standards\StandardPlatesPDF  

Print an empty border sheet to PDF, with or without project numbers & page numbers. Or get a copy 
from U:\rd\Doc\PDF   or the Office of Road Design’s WEB page. (http://www.sddot.com/business/
design/docs/downloads/emptyborder.pdf) 

2. Open a PDF with an empty border sheet. 

 If not landscape rotate page. 

4. Select Markup > Stamp > Change Stamp Folder    

5. Select Standard Plate Download Folder 

6. Select Standard Plate(s) from Stamp Folder> Place Standard Plate(s) as a Stamp > Horizontal 

      Alignment from Left. 

7. When Standard Plate placement is complete change Stamp folder back to original folder which  
      is located at C:\ProgramData\Bluebeam Software\Bluebeam Revu\Stamps. 
 

8.  Place “Not For Construction” Stamp on the Standard Plate Sheets. 
 
 

 

Note: You can add project numbers & page numbers using “Add Header & Footers” in Adobe. Do 
not  use any commenting Tools to fill in project numbers & page numbers. 
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Alternate Procedures for Comments Outside of the Studio Session 

1. A full copy of the review plans pdf was sent to an entity for review outside of the Studio Session 
and that copy was sent back to the Project Manager by the end of the review with comments 
included in the pdf. 

 The pdf that was received shall be named to identify who made the comments and then 
 added to the Studio Session as a second document.  The Consultants/designers  can then 
 proceed to reply to the comments and make revisions.  Separate e-mails will be required 
 if comments are rejected. 

2. A full copy of the review plans pdf was sent to an entity for review outside of the Studio                             
Session and A separate document was received that was not a pdf either electronically or hard 
copy.  

  If the document was sent electronically then it should be converted to a pdf and named too 
 identify who made the comments and then added to the Studio Session as a second 
 document.  If the document was sent hard copy the document should be scanned into a pdf 
 and named to identify who made the comments and then added to the Studio Session as a 
 second document. Separate e-mails will be required if comments are rejected. 
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Bluebeam Revu Studio Session Procedures for SDDOT Projects  

Once proper electronic documents are submitted, the SDDOT project manager shall combine the 
separate PDF’s into a single PDF and name the combined file as shown on pages 56-57. Note: 
The Project Manager may add the Utility Spec., Utility Plans, Building Spec. and Building Plans as 
a separate document(s) in the Session Review. 

1. The SDDOT project manager shall start a Session as shown on pages 75-79 of this manual. 

      Make sure that the Session Name in the Session Invitation has the CountyPCN# Review Due 

      Date Time Ex: Minn025C 08-15-16 5 PM.  The project description shall also be placed in the 

      Message of the Session Invitation. If the project is a FHWA oversight project, include the 

      FHWA reviewers email addresses in the review attendee list when you set the Session up. 

      FHWA already has Bluebeam Vu installed on their computers. If Local Governments or other 

      entities would prefer to do a electronic review include their email addresses in the attendee list. 

      They will be able to download the free Bluebeam Vu software from a link in the Bluebeam Revu 

      Session invite email that they will receive. Make sure that all Consultants/Designers are 

      included in the Session along with the list of Reviewers.  

2. The Reviewers shall follow the instructions on Pages 9-11 of this manual.  If review comments 

      are going to be late and can not be added to the Session before it ends please notify the 

      project manager that invited you to the Session. 

3. When the Session has ended the SDDOT project manager shall proceed with the review 

      response process for the Consultants/Designers so that they can make review responses/ 

      revisions (See pages 80-84). Every comment shall have a “Reply” and a “Status”. Any 

      Consultant/Designer that rejects a comment shall Alert the person that made the review 

      comment with the Bluebeam Alert process (See pages 83-84).  The SDDOT project manager 

      shall assure that all reviewers with rejected comments be notified with a justification/response 

      by reviewing the Session Report Record Summary that is created (Page 85) when the plan 

      review is archived or by checking their emails. The SDDOT project manager shall send the 

      Consultants a copy of the PDF Package Report on the DOT FTP Site.  After the Session 

      Report is created the SDDOT project manager shall Finish the Session by following the 

      instructions on page 86.  The SDDOT project manager shall then send a Memorandum/Letter 

      to Bid Letting following the requirements as shown on page 87. 

 

 

 93 


	Appendix
	Electronic PDF Plans 						
	PDF from Word or Excel with Bluebeam Revu 
	Adding “Not For Construction” as a Stamp
	Removing the Stamp “Not For Construction” 
	Adding “Preliminary” as a Stamp (ROW Plans – Only)
	Removing the Stamp “Preliminary” (ROW Plans – Only)
	Standard Plates in Bluebeam Revu 11x17 sheets


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /CMYK
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments true
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<

    /BGR <>
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e9ad88d2891cf76845370524d53705237300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc9ad854c18cea76845370524d5370523786557406300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /CZE <>
    /DAN <>
    /DEU <>
    /ESP <>
    /ETI <>
    /FRA <>
    /GRE <>

    /HRV (Za stvaranje Adobe PDF dokumenata najpogodnijih za visokokvalitetni ispis prije tiskanja koristite ove postavke.  Stvoreni PDF dokumenti mogu se otvoriti Acrobat i Adobe Reader 5.0 i kasnijim verzijama.)
    /HUN <>
    /ITA <>
    /JPN <FEFF9ad854c18cea306a30d730ea30d730ec30b951fa529b7528002000410064006f0062006500200050004400460020658766f8306e4f5c6210306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103055308c305f0020005000440046002030d530a130a430eb306f3001004100630072006f0062006100740020304a30883073002000410064006f00620065002000520065006100640065007200200035002e003000204ee5964d3067958b304f30533068304c3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020ace0d488c9c80020c2dcd5d80020c778c1c4c5d00020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /LTH <>
    /LVI <>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die zijn geoptimaliseerd voor prepress-afdrukken van hoge kwaliteit. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /POL <>
    /PTB <>
    /RUM <>
    /RUS <>
    /SKY <>
    /SLV <>
    /SUO <>
    /SVE <>
    /TUR <>
    /UKR <>
    /ENU (Use these settings to create Adobe PDF documents best suited for high-quality prepress printing.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /ConvertToCMYK
      /DestinationProfileName ()
      /DestinationProfileSelector /DocumentCMYK
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure false
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles false
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /DocumentCMYK
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /UseDocumentProfile
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


